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            Introduction

          

        

      

    

    
      This book includes the content of three separate titles, Excel for Beginners, Word for Beginners, and PowerPoint for Beginners, which are in my mind the three main Microsoft Office programs. By the time you finish this book you should be able to comfortably work in all three at a solid beginner level. That means opening each program and performing normal, everyday tasks.

      As you work through this book you’ll start to see that all Microsoft Office programs operate from the same basic foundation and that they share the same structure and many of the same shortcuts, so being familiar with one program will help you to learn the others.

      The screenshots and instructions in this book are written based on Microsoft Office 2013. For anyone using Office 2007 or later you should be able to do anything covered here even if you’re using a different version of Office. Yes, Microsoft does release new versions of Office on a regular basis, but the changes they tend to make are to the more advanced functions. Since these books cover the basic building blocks of Office, those rarely change over time.

      (As a matter of fact, the only major change I recall happening in the twenty-five years I’ve been using Microsoft Office was that switch to Office 2007 that drastically changed the appearance of all of the programs and moved everything around. But even then the Ctrl shortcuts and many of the right-click dropdown menus stayed the same.)

      Since these books were originally written to standalone, there will be some overlap in the introductions for each where terminology is discussed, but it’s still a good idea to read each title from start to finish.

      Good luck with it. Reach out if you get stuck.
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          Excel Essentials Book 1

        

      

    

    
    

  


  
    
      
        
          
          

          
            Introduction

          

        

      

    

    
      The purpose of this guide is to introduce you to the basics of using Microsoft Excel. I still remember when I was in college and helping a graduate student do research and he asked me to do something in Excel and I had no idea what to do and how frustrating that was to be limited by my lack of knowledge. I was later fortunate enough to work with a man who was absolutely brilliant with Excel who taught me lots of tips and tricks for using it and now I don’t know what I’d do without it.

      Excel is great. I use it both in my professional life and my personal life. It allows me to organize and track key information in a quick and easy manner and to automate a lot of the calculations I need. I have a budget worksheet that I look at at least every few days to track whether my bills have been paid and how much I need to keep in my bank account and just where I am overall financially. In my professional career I’ve used it in a number of ways, from analyzing a series of financial transactions to see if a customer was overcharged to performing a comparison of regulatory requirements across multiple jurisdictions. While it works best for numerical purposes, it is often a good choice for text-based analysis as well, especially if you want to be able to sort your results or filter out and isolate certain results.

      If you want to learn Excel through the lens of managing your own money, the Juggling Your Finances: Basic Excel Primer, is probably a better choice. It walks you through how to do addition, subtraction, multiplication, and division using key questions you should be able to answer about your personal finances as the examples.

      This book just focuses on the basics of using Excel without those kinds of specific examples. We’ll cover how to navigate Excel, input data, format it, manipulate it through basic math formulas, filter it, sort it, and print your results.

      This is not a comprehensive Excel guide. We are not going to cover more complex topics like conditional formatting and pivot tables. The goal of this guide is to give you a solid grounding in Excel that will let you get started using it. For day-to-day uses, this guide should cover 98% of what you need and I’ll give you some tips on how to find the other 2 percent. (Or you can continue on with Intermediate Excel which covers more advanced topics like pivot tables, charts, conditional formatting, and IF functions.)

      One note before we start: I'm working in Excel 2013, which will look familiar to users of Excel 2007 or later. If you're working in a version of Excel that’s pre-2007, I’d recommend that you upgrade now rather than try to learn Excel in an older version. They’re different enough that it’s really like a completely different program.

      If you do insist on using an older version of Excel, when I give you more than one method you can use (sometimes there are at least three ways to do the same thing in Excel), choose the option that tells you to right-click and open a dialogue box. Also, the Ctrl + [letter] options should be available in all versions of Excel. If that fails, use the help function to search for how the task can be completed in your version.

      Alright then. Let’s get started.
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      First things first, we need to establish some basic terminology so that you know what I’m talking about when I refer to a cell or a row or a column, etc.
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      Excel uses columns and rows to display information. Columns run across the top of the worksheet and, unless you've done something funky with your settings, are identified using letters of the alphabet. As you can see below, they start with A on the far left side and march right on through the alphabet (A, B, C, D, E, etc.). If you scroll far enough to the right, you'll see that they continue on to a double alphabet (AA, AB, AC, etc.).

      
        
          [image: Columns Example]
        

      

    

  


  
    
      
        
          
          

          
            Row

          

        

      

    

    
      Rows run down the side of the worksheet and are numbered starting at 1 and up to a very high number. You can hold down the ctrl key in a blank worksheet while hitting the down arrow to see just how many rows your version of Excel has. Mine has 65,536 rows per worksheet.
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            Cell

          

        

      

    

    
      A cell is a combination of a column and row that is identified by the letter of the column it's in and the number of the row it's in. For example, Cell A1 is the cell in the first column and the first row of the worksheet. When you've clicked on a specific cell it will have a darker border around the edges like in the image below.
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      If I tell you to click on something, that means to use your mouse (or trackpad) to move the arrow on the screen over to a specific location and left-click or right-click on the option. (See the next definition for the difference between left-click and right-click).

      If you left-click, this selects the item. If you right-click, this generally creates a dropdown list of options to choose from. If I don't tell you which to do, left- or right-click, then left-click.

    

  


  
    
      
        
          
          

          
            Left-click/Right-click

          

        

      

    

    
      If you look at your mouse or your trackpad, you generally have two flat buttons to press. One is on the left side, one is on the right. If I say left-click that means to press down on the button on the left. If I say right-click that means press down on the button on the right. (If you're used to using Word or Excel you may already do this without even thinking about it. So, if that's the case then think of left-click as what you usually use to select text and right-click as what you use to see a menu of choices.)

      Now, as I sadly learned when I had to upgrade computers and ended up with an HP Envy, not all track pads have the left- and right-hand buttons. In that case, you’ll basically want to press on either the bottom left-hand side of the track pad or the bottom right-hand side of the trackpad. Since you’re working blind it may take a little trial and error to get the option you want working. (Or is that just me?)

    

  


  
    
      
        
          
          

          
            Spreadsheet

          

        

      

    

    
      I'll try to avoid using this term, but if I do use it, I'll mean your entire Excel file. It's a little confusing because it can sometimes also be used to mean a specific worksheet, which is why I'll try to avoid it as much as possible.
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      A worksheet is basically a combination of rows and columns that you can enter data in. When you open an Excel file, it opens to worksheet one.

      My version of Excel has one worksheet available by default when I open a new Excel file. (It's possible to add more as needed.) That worksheet is labeled Sheet 1 and the name is highlighted in white to show that it’s in use.
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      This is the long white bar at the top of the screen with the ƒχ symbol next to it. If you click in a cell and start typing, you'll see that what you type appears not only in that cell, but in the formula bar. When you input a formula into a cell and then hit enter, the value returned by the formula will be what displays in the cell, but the formula will appear in the formula bar when you have that cell highlighted.
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      I refer to the menu choices at the top of the screen (File, Home, Insert, Page Layout, Formulas, Data, Review, and View) as tabs. Note how they look like folder tabs from an old-time filing system when selected? That's why.
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      Each menu tab you select will show you different options. On my Home tab I can do things like copy/cut/paste, format cells, edit cells, and insert/delete cells, for example. (This is one place where things are very different for those using earlier versions of Excel and why if you're using an older version of Excel, I'd recommend upgrading now.)
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      On the right side and the bottom of the screen are two bars with arrows at the ends. If you left-click and hold on either bar you can move it back and forth between those arrows (or up and down for the one on the right side). This lets you see information that's off the page in your current view but part of the worksheet you're viewing.

      You can also use the arrows at the ends of the scroll bar to do the same thing. Left-click on the arrow once to move it one line or column or left-click and hold to get it to move as far as it can go. If you want to cover more rows/columns at a time you can click into the blank space on either side of the scroll bar to move an entire screen at a time, assuming you have enough data entered for that.
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      Using the arrows instead of clicking on the scroll bar lets you scroll all the way to the far end of the worksheet. Using the scroll bars only lets you move to the end of the information you’ve already entered.
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      I use data and information interchangeably. Whatever information you put into a worksheet is your data.

    

  


  
    
      
        
          
          

          
            Table

          

        

      

    

    
      I may also refer to a table of data or data table on occasion. This is just a combination of rows and columns that contain information.
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      If I tell you to "select" cells, that means to highlight them. If the cells are next to each other, you can just left-click on the first one and drag the cursor (move your mouse or finger on the trackpad) until all of the cells are highlighted. When this happens, they'll all be surrounded by a dark box like below.

      

      
        
          [image: Selected cells next to one another]
        

      

      If the cells aren't next to each other, then what you do is left-click on the first cell, hold down the Ctrl key (bottom left of my keyboard), left-click on the next cell, hold down the Ctrl key, left-click on the next cell, etc. until you've selected all the cells you want. The cells you've already selected will be shaded in gray and the one you selected last will be surrounded by a dark border that is not as dark as the normal border you see when you just select one cell. In the image below cells A1, C1, A3, and C3 are selected.

      
        
          [image: Selected cells not touching]
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      If you didn't know this one already, it's what moves around when you move the mouse (or use the trackpad). In Excel it often looks like a three-dimensional squat cross or it will look like one of a couple of varieties of arrow. (Open Excel and move it to where the column and row labels are to see what I mean.) The different shapes the cursor takes represent different functions.

    

  


  
    
      
        
          
          

          
            Arrow

          

        

      

    

    
      If I say that you can "arrow" to something that just means to use the arrow keys to navigate from one cell to another. For example, if you enter information in A1 and hit enter, that moves your cursor down to cell A2. If instead you wanted to move to Cell B1, you could do so with the right arrow.
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      I will occasionally refer to a dropdown or dropdown menu. This is generally a list of potential choices that you can select from. The existence of the list is indicated by an arrow next to the first available selection.

      

      
        
          [image: Dropdown menu examples]
        

      

      I will also sometimes refer to the list of options you see when you click on a dropdown arrow as the dropdown menu.
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      Dialogue boxes are pop-up boxes that contain a set of available options and appear when you need to provide additional information or make additional choices. For example, this is the Insert dialogue box that appears when you choose to insert a cell:

      
        
          [image: Insert cells dialogue box]
        

      

    

  


  
    
      
        
          
          

          
            Absolute Basics

          

        

      

    

    
      It occurs to me that there are a few absolute basics to using Excel that we should cover before we get into things like formatting.
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      To start a brand new Excel file, I simply click on Excel 2013 from my applications menu or the shortcut I have on my computer’s taskbar, and it opens a new Excel file for me.

      If you’re opening an existing Excel file, you can either go to the folder where the file is saved and double-click on the file name, or you can (if Excel is already open) go to the File tab and choose Open from the left-hand menu.

      

      
        
          [image: Opening an Excel file]
        

      

      That will show you a list of Recent Workbooks. If it includes the one you’re looking for, you can just click on it once and it will open.

      

      
        
          [image: Navigation options]
        

      

      If you don’t see the file you’re looking for, you can click on the list of navigation options in between the left-hand menu and the list of Recent Workbooks and navigate to where the file is stored. When I click on Computer it gives me the current folder I’m in as well as five recent folders and an option to browse if the folder I want isn’t one of the ones displayed.

    

  


  
    
      
        
          
          

          
            Saving an Excel File

          

        

      

    

    
      To save a file you can go to the File tab at the top of the screen and then choose Save or Save As from the menu options on the left side.

      

      
        
          [image: Saving a file]
        

      

      When you’re dealing with a new Excel file, you really only have the Save As option. (When I click on Save it still takes me to Save As.) With Save As, Excel will ask you to choose which folder to save the file into. You can either choose from the list of recent folders on the right-hand side or navigate to the folder you want using the locations listing on the left of that list.

      

      
        
          [image: Save location options]
        

      

      Once you choose a location, a dialogue box will appear where you can name the file.

      

      
        
          [image: Save location dialogue box]
        

      

      My save options default to an .xls file type. I don’t know if this is standard or if I’ve set it up that way somewhere. If yours doesn’t default to the .xls file type, I’d recommend using that file type as much as possible if you think you might share the file at any point. The newer versions of Excel actually are an .xlsx file type, but if you use that file type and want to share with someone who has a version of Excel that’s pre-2007, they won’t be able to open your file.

      It’s much easier to save down to an older version than have to convert up to a newer version. And I’m pretty sure if you’re using this guide you won’t be using any of the fancy options that are available in the newest versions of Excel that aren’t available in older versions. If it turns out you are, Excel will generate a warning message about compatibility when you save the file as an .xls file, and you can decide not to save it to the older version at that time.

      If you’re saving a file you’ve already saved once before and you have no changes to its name, location, or type, you can go to File>Save and it will save it for you, keeping all of that information the same. You can also just type Ctrl and S at the same time (Ctrl+S) (Note: Even though I’m going to show these commands with a capital letter, you don’t have to use the capitalized version of the letter.)

      Or, and I think this is true of all Excel users, there should be a small computer disk image in the top left corner that you can click on. (You can customize that list and I have for my most-used functions, which is why I’m not 100% sure.)

      If you’re saving a file you’ve already saved once before but you want to save it to a new location, change its name, or change the file type (.xls to .xlsx, for example), use Save As.

    

  


  
    
      
        
          
          

          
            Deleting an Excel File

          

        

      

    

    
      You can’t delete an Excel file from within Excel. You’ll need to navigate to the folder where the file is stored and delete the file there without opening it. First, click on the file name. (Only enough to select it. Make sure you haven’t double-clicked and highlighted the name which will then try to rename the file.) Next, choose Delete from the menu at the top of the screen, or right-click and choose Delete from the dropdown menu.

    

  


  
    
      
        
          
          

          
            Renaming an Excel File

          

        

      

    

    
      You might want to rename an Excel file at some point. You can Save As and choose a new name for the file, but that will mean you now have two versions of the file, one with the old name and one with the new name. Or you can navigate to where you’ve saved the file, click on it once to highlight the file, click on it a second time to highlight the name, and then type in the new name you want to use. If you do it that way, there will only be one version of the file, the one with the name you wanted.

      If you do rename a file, know that you can’t then access it from the Recent Workbooks listing under Open file. Even though it might be listed there, Excel won’t be able to find it because it no longer has that name. (Same thing happens if you move a file from the location it was in when you were last working on it. I often run into this by moving a file into a new subfolder when I suddenly get inspired to organize my records.)

    

  


  
    
      
        
          
          

          
            Navigating Excel

          

        

      

    

    
      The next thing we’re going to discuss is basic navigation within Excel. These are all things you can do that don’t involve inputting, formatting, or manipulating your data.

    

  


  
    
      
        
          
          

          
            Basic Navigation Within A Worksheet

          

        

      

    

    
      Excel will automatically open into cell A1 of Sheet 1 for a new Excel file. For an existing file it will open in the cell and worksheet where you were when you last saved the file. (This means it can also open with a set of cells already highlighted if that’s what you were doing when you last saved the file.)

      Within a worksheet, it’s pretty basic to navigate.

      You can click into any cell you can see in the worksheet with your mouse or trackpad. Just place your cursor over the cell and left-click.

      From the cell where you currently are (which will be outlined with a dark border), you can use the up, down, left, and right arrow keys to move one cell in any of those directions.

      You can also use the tab key to move one cell to the right and the shift and tab keys combined (shift + tab) to move one cell to the left.

      To see other cells in the worksheet that aren’t currently visible, you can use the scroll bars on the right-hand side or the bottom of the worksheet. The right-hand-side scroll bar will let you move up and down. The bottom scroll bar will let you move right or left. Just remember that the bars themselves will only let you move as far as you’ve entered data, you need to use the arrows at the ends of the scroll bars to move farther than that.

      For worksheets with lots of data in them, click on the scroll bar and drag it to move quickly to the beginning or end of the data. To move one view’s worth at a time, click in the blank space around the actual bar.

      If you’re using the scroll bars to navigate, remember that until you click into a new cell with your mouse or trackpad you will still be in the last cell where you clicked or made an edit. (You can test this by typing and you’ll see that you’re brought back to that last cell, wherever it is.)
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      If you click in a cell and hit the F2 key, this will take you to the end of the contents of the cell. This can be very useful when you need to edit the contents of a cell or to work with a formula in that cell.
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      Between worksheets, you can either click on the name of the worksheet you want (at the bottom of the screen) or you can use Ctrl and Page Up (Ctrl + Page Up) to move one worksheet to the left and Ctrl and Page Down (Ctrl + Page Dn) to move one worksheet to the right.

    

  


  
    
      
        
          
          

          
            Adding a New Worksheet

          

        

      

    

    
      When you open a new Excel file, you'll have one worksheet you can use named Sheet 1. (In Excel 2007 I had three worksheets available when I opened a new file.)

      If you need another worksheet, simply click on the + symbol in a circle at the end of your existing worksheets to add a new one. (In Excel 2007 the add a worksheet option looked like a mini worksheet with a yellow star in the corner.)

      
        
          [image: Insert Worksheet Option 1]
        

      

      You can also go to the Home tab under the Cells section and left-click the arrow under Insert then select Insert Sheet from the dropdown menu.

      
        
          [image: Insert Worksheet Option 2]
        

      

    

  


  
    
      
        
          
          

          
            Deleting a Worksheet

          

        

      

    

    
      Sometimes you’ll add a worksheet and then realize you don’t want it anymore. It’s easy enough to delete. Just right-click on the name of the worksheet you want to delete and choose the Delete option from the dropdown menu.

      

      
        
          [image: Delete worksheet]
        

      

      You can also go to the Cells section in the Home tab, left-click on the arrow under Delete, and choose Delete Sheet from the dropdown menu.

      

      
        
          [image: Delete sheet option on Home tab]
        

      

      If there was any data in the worksheet you’re trying to delete, it will give you a warning message to that effect. If you don’t care, click Delete. If you didn’t realize there was data and want to cancel the deletion, click Cancel.

      Be sure you want to delete any worksheet you choose to delete, because you can’t get it back later. This is one place where undo will not work.
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